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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “ XXXXX" is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP3423 Evaluation Board. ltems discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP3423 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

* Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP3423 Evaluation Board and instructions on how to use the MCP3423
Evaluation Board with the PICkit Serial Analyzer.

» Appendix A. “Schematic and Layouts” — shows the schematic and layout
diagrams for the MCP3423 Evaluation Board.

» Appendix B. “Bill of Materials (BOM)" — lists the parts used to build the
MCP3423 Evaluation Board.

© 2008 Microchip Technology Inc. DS51778A-page 1



MCP3423 Evaluation Board User’'s Guide

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxFF, <A’

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS51778A-page 2
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP3423 Evaluation Board. Other useful
documents are listed below. The following Microchip document is available and
recommended as supplemental reference resources:

PICkit™ Serial Analyzer User’s Guide (DS51647)

Consult this document for instructions on how to use the PICKit Serial Analyzer
hardware and software.

MCP3422/3/4 Data Sheet, “ 18-Bits, Multi-Channel Delta-Sigma Analog-to-Digital
Converter with I2C Interface and On-Board Reference” (DS22088)

This data sheet provides detailed information regarding the MCP3423 product family.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY
Revision A (November 2008)

« |nitial Release of this Document.

© 2008 Microchip Technology Inc. DS51778A-page 3
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Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP3423 Evaluation Board and
demonstrate how to use it with the PICkit™ Serial Analyzer (P/N: DV164122).

The following topics are covered:

* Description of the MCP3423 Evaluation Board
* How to use MCP3423 Evaluation Board with the PICkit Serial Analyzer

1.2 DESCRIPTION OF THE MCP3423 EVALUATION BOARD

The MCP3423 Evaluation Board (P/N MCP3423EV) contains a MCP3423 18-Bit AZ
Analog-to-Digital Converter (ADC). The MCP3423 is a 2-channel 18 bit delta-sigma
ADC device with various configuration options. The board has analog input connection
pads and various test pads.

The user can connect inputs and test the conversion results using the PICkit Serial

Analyzer and its PC graphic user interface (GUI). The MCP3423 Evaluation Board has

the following interfaces:

 PICKkit Serial Analyzer (P/N: DV164122) for writing configuration register bits and
reading the conversion data.

Note: The user can use this board without the PICkit Serial Analyzer as long as
the Vpp, SCL, and SDA are provided through J1 connector. This Evaluation
Board does not include MCU.

The board has test points for SDL, SDA, and analog inputs. By connecting an
oscilloscope to these test points, the user can examine the data communications
through the 12C™ bus line and observe the resulting conversion output. Refer to
Appendix A. “Schematic and Layouts”.

1.2.1 I2C Address Bits and A0 Address Bit Selection

The I12C device code and address bits of the MCP3423 device are:

* Device Code: “1101~
+ A2, A1, AO Address Bits: determined by the JP2 (Adr1 pin) and JP3 (AdrO pin).
« See Table 1-1 for the 12C Device Address bits and JP2 and JP3 connections.

© 2008 Microchip Technology Inc. DS51778A-page 5
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102-00230

. MCP3423
" = Eval board

kA GND

_ MicrocHIP © ©

7l

FIGURE 1-1: Front View of the MCP3423 Evaluation Board.

1.3 GETTING STARTED WITH PICKIT SERIAL ANALYZER

Figure 1-1 shows the MCP3423 Evaluation Board, and Figure 1-2 shows the
MCP3423 and PICkit Serial Analyzer.
The following describes how to use them together:
1. Connect the MCP3423 Evaluation Board’s 6-pin socket to the PICkit Serial
Analyzer as shown in Figure 1-2.
2. Connect the oscilloscope probes to the SCL and SDA test pins (optional).
3. Vpp Selection: You can use the Vpp from the PICkit Serial Analyzer or use your
own external Vpp. The JP1 connector selects the Vpp path.
(a) Connect JP1, if using Vpp from PICkit Serial Analyzer.
(b) Disconnect JP1 and apply Vpp at Vpp1 pin, if you are using an external Vpp.
4. Address bit selection using JP2 and JP3 connectors.
The I1°C device code and address bits of the MCP3423 device are:

« MCP3423 I2C device code: <1101~

* A2, A1, A0 Address Bits: determined by the JP2 (Adr1 pin) and JP3 (Adr0 pin)

* The JP2 and JP3 connectors are external address bit selections. Connect these
pins to Vgg, Vpp, float, or connect any arbitrary voltage

« See Table 1-1 for the 12C Device Address bits and JP2 and JP3 connections

5. Connecting Vpp: LED D1 turns on when Vpp is applied. The PICkit Serial
Analyzer will provide Vpp automatically, if it is connected to the PC. Make sure
LED D1 turns on, when you execute the command using the PICkit Serial
Analyzer.

DS51778A-page 6 © 2008 Microchip Technology Inc.
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6. Connecting the analog inputs: If you need to measure a single-ended input,

connect the unused pin (example, CHx-) to Vgs.

» Connecting the inputs: The MCP3423 Evaluation Board has input pads for two
analog input channels. You can connect all inputs at the same time and multiplex
the input channel using configuration register settings. You can also leave the
unused channel inputs floating.

7. Use the PICkit Serial Analyzer PC GUI to send I°C write and read commands.

CAUTION

Sheet.

Each analog input pin has an ESD diode. Certain input conditions can damage the
device. Please use the following conditions:
(a) Do not apply an input greater than the input range specified by the MCP3423 Data

(b)Apply the input signal after Vpp is powered-up.

TABLE 1-1:

I°C ADDRESS BITS VS. JP2 AND JP3 CONNECTORS

I2C Device Address
Bits

JP2 (Adrl Pin)

JP3 (Adr0 Pin)

1101 000 W/R

Connected to Vgg

Connected to Vgg

1101 001 W/R

Connected to Vgg

Float

1101 010 W/R

Connected to Vgg

Connected to Vpp

1101 100 W/R

Connected to Vpp

Connected to Vgg

1101 101 W/R

Connected to Vpp

Float

1101 110 W/R

Connected to Vpp

Connected to Vpp

1101 011 W/R Float Connected to Vgg
1101 111 W/R Float Connected to Vpp
1101 000 W/R Float Float

Note 1: WIR bit = “0" for writing, “1” for reading.

2:  Float: (a) Leave pin without connecting to anything, or (b) apply Addr_Float voltage.
See MCP3423 Data Sheet for more details.

© 2008 Microchip Technology Inc.
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Personal
Computer

USB Cable

Connected between the
PICkit Serial Analyzer
and Personal Computer

PICkit Serial Analyzer

Sensor Input

Connectors
ri ) S P
MCP3423 Evaluation Board
FIGURE 1-2: MCP3423 Evaluation Board with the PICkit Serial Analyzer.

131 PICkit Serial Analyzer PC Software Setup for the MCP3423
Evaluation Board

The following steps describe how to set up and use the PICkit Serial Analyzer PC
Graphic User Interface (GUI).

1. Install the PICKit Serial Analyzer software onto your personal computer (PC).
2. Connect the USB cable between the PICkit Serial Analyzer and the PC.

3. Run the PICkit Serial PC Software - it will open to the following GUI:

DS51778A-page 8 © 2008 Microchip Technology Inc.
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Configuration Wizard E

Welcome To The
PICkit Serial Analyzer
- = Configuration Wizard

hatle 0 The following steps Wi“ quide you through the
Sfw o etupof the PICkit Serial Analyzer.

el

Tl

Imiy
oy

K

|| MHext = | Cancel

FIGURE 1-3: PICKit Serial Analyzer Configuration Window welcome window.

Click the Next button and follow the instructions.

4. Select the Communication Mode type: 12C Master, and click the Next button.

Configuration Wizard n

Communication Mode - Page 1 of 4

Chooze which mode of communication you wish bo uze.

%

I2C Maszter

7 5P| Master

" USART Asunc

T USART Spnc Master

¢ Back Mest > Cancel

FIGURE 1-4: Step 1 - Communication Mode selection.
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5. In the new window, select “100 kHz” or “400 kHz". Either one will be fine. Click
the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4

Select pour 12C communication speed

Communication speed may alza be
I 100kHz  adjusted by using the ‘Configure
% A00 kHz tode' page from the 'PICKkIt Senal
Analvzer menu dropdawn after
completing the Configuration
YWizard.

< Back et » Cancel

FIGURE 1-5: Step 2 - 12C Communication Speed window.

Note: The MCP3423 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICKkit Serial Analyzer supports the 12C bus data rate
up to 400 kHz only.

DS51778A-page 10 © 2008 Microchip Technology Inc.
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6. Inthe Device Pullups window, select No on “Enable Pull-ups” and click the Next
button.

Note: The MCP3423 Evaluation Board has its own pull-up resistors. I

Configuration Wizard E

Device Pullups - Page 3 of 4

Da vou reed to enable pullupz for vour device™?

Enable Pullups
" Yes & Mo

¢ Back et > Cancel

FIGURE 1-6: Step 3 - Device Pullups window.

7. In this step, you have to select the Vpp voltage of the MCP3423 Evaluation
Board, then click the Next button.

Case 1: When you use Vpp from the PICkit Serial Analyzer:

If you choose PICKkit Serial will power your device and 5 Volts as shown in
Figure 1-7, the MCP3423 Evaluation Board is powered by the 5V DC from the
PICkit Serial Analyzer through the JP1 jumper. In this case, make sure that the
JP1 jumper on the MCP3423 Evaluation Board is connected.

Case 2: When you use your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at VD1
test point. In this case, make sure that the JP1 jumper is disconnected.

© 2008 Microchip Technology Inc. DS51778A-page 11
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Configuration Wizard E

Yoltage Source - Page 4 of 4

Dioes PICKI Senal need to power your device?

Yoltage
v FICkit Serial wil
power my device N
[f PICkit Serial will power your
fo BYalt device, select the checkbos to
 Other the [eft, then determine wour
voltage.

5.0

¢ Back MHenst > Cancel

FIGURE 1-7: Step 4 - Voltage Source selection window.

8. Click the OK button. You have made all of the PICkit Serial Analyzer
Configuration Setups. You are now ready to program the MCP3423 Evaluation
Board using the PICkit Serial Analyzer.

Configuration Wizard E

You're Donel!

Prezz '0OF' to complete the Configuration Wizard.

[ Do mot show thiz wizard on startup again

“Wizard may be accessed anytime from
menu drapdawn PICKE Senial Analpzer -»
Fun Configuration ‘Wwizard.

oK

FIGURE 1-8: Configuration Wizard - Finishing step.
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1.3.2 Creating Script Files

In order to make a communication connection between the PICkit Serial Analyzer and
the MCP3423 Evaluation Board, a script file is needed. Figure 1-9 shows how to create
script files and how to use them.

* In the PICKit Serial Analyzer window, select from the menu Communications>
Script>Script Builder .

4 PICkit Serial - 12C Master Mode B BEE

Communications | PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

Basic Operations sic Operations | Reset 12C_M

Script 3 Script Builder | = I Gtatus

M Update

W E:ecutive Error
I Communication Error

I 12C Errar
" i -ojx
Transactions BitRate: 100.0 kHz

1 . Source Voltage: 4.8%
File ~ Edit > Clear Data Line Woltage: 484
Clock Line Woltage: 4.7%

Script Execute

02/13,/2007 4:59:14 FM

Welcome to PICkit Serial wersion 2.0.1.0

Found PICkits.d11 - Ver: 1.3.0.0

Found PICkit Serial Analyzer - FW Ver: OxD108
USE control block updated with preference data.

Basic Wiew Set.

FIGURE 1-9: Creating a script file with Script Builder.

1.3.2.1  CREATING SCRIPT FILE FOR CONFIGURATION BYTE WRITING

1. Click on WriteBlockAddrA8 in “Example 12c Scripts” column.
This will result in filling in the spaces under the “Script Detail” column.

You can now modify the “Script Detail” column parameters by right-clicking the
mouse.

How to modify the parameters box in Script Details:

1. Under the “Script Detail” box, select the item in the parameter box.

2. Right click the mouse button and an option box appears to the right of your
selection. These are the options available for the parameter selected.

3. Select the desired option and delete or insert the parameter box.
4. Keep the parameters in order as shown in Figure 1-10:

© 2008 Microchip Technology Inc. DS51778A-page 13
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il P|Ckit Serial - 12C Master Mode

Communicakions  PICKiE Serial Analvzer  Demo Boards  User Defined Templates  View  Window  Help

View: Basic | Communications: Basic Operations | Reset

Script Builder _ ol %]

wample cripts cript Detal 21 cripts
E le |2C Scri Script Detail Uszer |22 Scri
Script Mame Headﬂ.ddrﬂﬂ I2CSTART 1=l I'-.-1F'44 Genalfl'-. -
MCP3423_wit_CHT WriteAddiAg | 3, :
WiriteBlockAddrAl || 20w RTEYT
i FAeadBlockAddriad ||:|2
Save Scrpt ®
oC »
Execute Script /> |
1. Tochange value: |E||: =
Clear Script I (TS ]2 _
2. To delete or Insert a new box:
» Choose the box and right | ®
- click the mouse button
Del User Scripts for options available | =
3. Make sure the listed | o
parameters in “script Detail”
Show Array are in the exact order as | o
shown here.
| x
| x
| x
| x o B
FIGURE 1-10: Modifying parameters in Script Builder window.

4. Change the parameter value:

Script Detail

[2CSTART *

[2CWRTBYT | *
02 —»This means there are two bytes to send

DC ———»1st Write Byte: Address byte with WI/R bit = 1101-1100
9C —»2nd Write Byte: 1001-1100

[2CSTOP *

Note: All six parameters above must be listed in order. The parameter above
marked with * character are not modifiable. Address bits (A2, A1, A0) =
(1,1,0) if both JP2 and JP3 are tied to Vpp. You can use different address
bits by rearranging the connectors. See MCP3423 Data Sheet for more
information on address bit sections.

DS51778A-page 14 © 2008 Microchip Technology Inc.
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adl PICkit Serial - 12C Master Mode
Communicaktions  PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

View: Basic | Communicakions: Basic Operations | Reset

Script Builder o x

Example |2C Scripts Script Detail dzer I2C Scripts
Script Mame Feaddddiag 1= MCP3424 GenCald «
|M|:F'3423 wit CHI Writedddrd g |I2EST'&'HT RMCP3423 Wit CHA
= WiiteBlockaddiag |I2EWFETBYT MCP3423 wit_CH:
i ReadBlockAddrisd 02
Save Script | | 2
oC x
Execute Script | 2 Bytes to send |EII: =
Clear Script | |I2ESTEIF' —
ress Byte
y | "
Del User Scripts | Configuration Byte | *
(90) | x
Show Array | | ”
| ®
| %

Note: The “9C” in the configuration byte selects the following options:
- Conversion Mode: Continuous Conversion
- Channel Selection: Channel 1
- Bit Resolution: 18 bits
- Gain Selection: 1x

FIGURE 1-11: Script file example for 12C Write Command.

1.3.2.2 SAVE THE SCRIPT FILE AND PROGRAMMING THE MCP3423
CONFIGURATION REGISTER

1. Change the 2" and 3™ data bytes you want in the Script Detail.

2. Type in any script name (i.e., MCP3423_ Write) in the space below the “Script
Name” menu.

3. Click Save Script button.
4. Click Execute Script button.

Note: At this point, the PICkit Serial transmits the 12C Write Command to the
MCP3423 device. The saved file name will appear in “Users 12C Scripts”
column, and can be re-used any time by selecting the file name.

© 2008 Microchip Technology Inc. DS51778A-page 15
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5. You can also see the SCL and SDA waveforms using the Oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 1°C
command.

Write Command with Address bits Configuration Bits

FIGURE 1-12: I2C Write Command Waveforms for the MCP3423.

DS51778A-page 16 © 2008 Microchip Technology Inc.



Quick Start Instructions

1.3.3 Trouble Shooting: If the device does not acknowledge the
commands

If the device is powered up initially with unstable Vpp from the PICKit Serial, there is a
chance that the device can latch a wrong address bits from the external address pins,
and therefore it may not acknowledge the command bytes correctly since the address
bits are not matched. In this case, send a General Call Latch Command after the Vpp
is stabilized (after about 20 seconds the PICKit Serial is powered). See the example in
Figure 1-13. Another method is power-up the PICKit Serial first by connecting to the

PC, then insert the MCP3423 EV board to the PICKit Serial about 20 seconds later.

(a) The device
does not
acknowledge the
write command.

N

NAK Pulse NAK Pulse

(b) Send a
General Call
Latch Command.

(c) The device
now acknowledge
the command.

ACK: Pulse / ACK Pulse/

FIGURE 1-13: Examples when the device is not acknowledging the write command. Send the
General Call Latch Command when the Vpp is stabilized.

© 2008 Microchip Technology Inc. DS51778A-page 17



MCP3423 Evaluation Board User’'s Guide

1.34 Reading the Conversion Data using the PICKkit Serial Analyzer

You can read back the conversion data with the following steps.

1.3.4.1  CREATING SCRIPT FILE TO READ CONVERSION DATA

1. Click on ReadAddrA8 in “Example 12C Scripts” column.
This will result in filling in the spaces under “Script Detail” column.

Now you can modify the parameter boxes (delete or insert) in the “Script Detail”
column with options. The list of options will appear if you right-click the mouse in
the parameter box. You can delete the parameter box or add a new one.

2. Make sure you have the “Script Detail” parameters listed in order as follows:

Script Detail
[2CSTART *
[2CWRTBYT *
01 —— This means there is one byte for address
DD —» Address byte with W/R bit = 1101-1101
[2CRDBYTNLB | *
5 — 5 bytes to read
[2CSTOP *

Note: All seven parameters above must be listed in order. The parameters above
marked with * character are not modifiable.
Address bits (A2, A1, A0) = (1,1,0) if both JP2 and JP3 are tied to Vpp. You
can use different address bits by rearranging the JP1 and JP2 connectors.
See MCP3423 Data Sheet for more information on address bit selections.
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Quick Start Instructions

il PICKkit Serial - 12C Master Mode

Communications  PICKiE Serial fnalvzer  DemoBoards  User Defined Templates  Wiew  Window  Help

View: Basic | Communications: Basic Operations = Reset

Script Builder =

Example 12C Scriptz —— Scrpt Detal 3 Ilzer [2C Scnpts
Script M ame A eadtddra s |I2I:ST.-“-‘-.F!T = MCF3424 GenCald a
||"-"||:F'3423 Read Writed ddrd g MCP3423 Wit CHT
= WiiteBlockaddras |I2EWF|TBYT MCPI423 Witk CH:
T FeadBlockAddriad |EI1 MCF3423 Read
Save Scrpt ‘ 5
_ o0 «
Execute Script | |I2I:FEDBYTNLE
.
Clear Script ‘ |5 3 A
{l2csTOP
Del Uzer Scnpts | Resqgstsélsng | x
f x
Show Amray | | "
| x
| x
f x
| x =
FIGURE 1-14: Script File sample to read conversion data.
3. Type in any script name (i.e., MCP3423 Read) in the space below the “Script
Name” menu.
4. Click Save Script button.
5. Click Execute Script button.

Note: At this point, the PICkit Serial transmits the 1°C Read Command to the

MCP3423 device. The saved file name will appear in “Users 12C Scripts”
column, and can be re-used any time by selecting the file name.

6.

You can also see the SCL and SDA waveforms using the Oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit

Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 1°C
command.
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adl PICkit Serial - 12C Master Mode

Communicakions  PICkt Serial Analyzer  Demo Boards  User Defined Templates  Yiew  Window  Help

View: Basic | Communications: Basic Operations | Resek

Script Builder _[=lx]

Example |2C Scrpts Scrpt Detal Ilzer |2C Scripts
Script Mame Hegdﬁ.ddrﬁ.ﬂ |I2EST.¢‘-.FET 1=l MEP‘S#Ed_GenEalﬂ.:
|M|:F'3423 Fead writedddra g MCP 3423 win_CH1
= WiriteBlockAddral |I2E'W'FITBYT MCF3423 wit CH:
i ReadBlockaddrad |EI1 MCP3423 Fead
Save Script | =
DD x
Execute Script | |I2EHDBYTNLB
Clear Scrnpt | |5 (!
|l2C5TOP
Del Uzer Scnpts | Requesting | x
| x
Show Array | S Bytes | -
| x
| x
| x
| * =

-Iolx

File = Edit = Clear

10:24 :d4 AM Sent script from Script Builder page, 10
bytes:

[5_10w_1[01][BO]RN][OS][P_] Reading Data
using a Read Command
(s_J@o]lFe] 7] [1c] (ac][P_]
A A A A A

5th Byte: Repeated Byte for Configuration byte
4th byte: Configuration Byte (note that RDYbit is “0”)
3rd byte: Data Byte

2nd byte: Data Byte

1st byte: Data Byte

Resulis:
Output code: F907 in hex ( = 63751 in decimal)
Output Voltage= 63751 x 15'625P GVA LSB) - 0.996 Volts with PGA = 1

Note that if the differential input voltage is negative (CH- > CH+), the MSB of the first byte will be "1". In this case, the
voltage is calculated after converting the output code to 2's complement and then multiply the LSB.

See Section 4.9 of the MCP3423 Data Sheet (DS22088) for more information.

FIGURE 1-15: Reading Conversion Results: Note that the Input = 0.996V is applied to CH1. The
reading indicates the measured value is 0.996 Volts.
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-
4

Data Bytes = 00F907 (hex)

(a) Read command and outputs. The 3 data bytes are zoomed in for better clarity.

Zoom-in

g ! L prm

Configuration Byte (4th) and Repeated Configuration Byte (5th)

(b) Read command and outputs. The last two data bytes are zoomed in for better clarity.

FIGURE 1-16: Read Command and Data on I°C bus. Note the RDY bit in 4th byte is “0”. This means
the conversion data just read is the latest conversion data. The RDY bit becomes “1” in the 5th byte
(repeated byte). This means the device is now in the process of new conversion and the new result is not
ready yet.
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1.4 EXPERIMENT FOR CH2

Repeat the instructions from Section 1.3.2 “Creating Script Files” to
Section 1.3.4 “Reading the Conversion Data using the PICKit Serial Analyzer” for
the input channel 2.
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MCP3423 EVALUATION BOARD
MICROCHIP USER’S GUIDE

Appendix A. Schematic and Layouts

A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP3424 Evalu-
ation Board:

» Board — Schematic

» Board — Top Layer

* Board — Top Metal Layer

* Board — Bottom Layer

* Board — Bottom Metal Layer

© 2008 Microchip Technology Inc. DS51778A-page 23
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BOARD - SCHEMATIC
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Schematic and Layouts

A.3 BOARD -TOP LAYER

Power

D1 RS

102—-00230

@ MCP3423
0 Eval board

VDD
VSS

Select

JIP2
Address
3

vDD
VSS

Adro
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A.4 BOARD - TOP METAL LAYER

Power

D1ig @ R5

SDA

J1
0000l 102—00230
>N Z
COOWMO N
Xrr>0nNoo
MCP3423

JP@ Eval board

Q n
a o
> >

9/ 0@-

JP2

[ ]
U1 %)m .
( MCP3423 )

®e Address

E Eo0 Select JP3
CougmuliC1 ™ rgee
R1lll.l|R3 =)
R2EW MW R4 e ?

Adro T

GND SCL
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A5 BOARD-BOTTOM LAYER

FA—0CS00—»OT

© 2008 Microchip Technology Inc. DS51778A-page 27




MCP3423 Evaluation Board User’'s Guide

A.6 BOARD-BOTTOM METAL LAYER

E N
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MICROCHIP

Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty Reference Description Manufacturer Part Number
1 C1 CAP .1UF 25V CERAMIC X7R 0805 Panasonic® - ECG ECJ-2VB1E104K
1 Cc2 CAP CERAMIC 10UF 6.3V X5R 0805 |Panasonic - ECG ECJ-2FB0J106K
1 D1 LED RED ORANGE CLEAR 0805 SMD |LITE-ON INC LTST-C170EKT
2 R1,R3 RES 4.99K OHM 1/8W 1% 0805 SMD | Panasonic - ECG ERJ-6ENF4991V
1 R5 RES 470 OHM 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ471V
1 J1 CONN HEADER 6POS .100 R/A TIN Molex® Waldom® 22-05-2061
Electronics
1 JP1 CONN HEADER 2POS .100 VERT TIN | Molex/Waldom 22-03-2021
Electronics
2 JP2,JP3 CONN HEADER 3POS .100" STR TIN | Molex/Waldom 90120-0123
Electronics
1 PCB RoHS Compliant Bare PCB, MCP3423 | Microchip Technology 104-00230
Evaluation Board for PICkit Serial Inc.
3 Shunts for 100" Shorting Block with Handle JAMECO Value-Pro 2012JH-R
JP1, JP2,
JP3
2 R2,R4 DO NOT POPULATE — —
1 U1 2 Channel 18 Bit Data Sigma ADC Microchip Technology MCP3423-E/ST
Inc.
14 |VDD1, TEST POINT PC COMPACT SMT Keystone Electronics® |5016
CH1+,CH1-,
CH2+, CH2-,
A0, A1, SCL,
SDA, GND
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.

© 2008 Microchip Technology Inc.
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WORLDWIDE SALES AND SERVICE
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2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200

Fax: 480-792-7277
Technical Support:

http://support.microchip.com

Web Address:
www.microchip.com

Atlanta

Duluth, GA

Tel: 678-957-9614
Fax: 678-957-1455

Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago

Itasca, IL

Tel: 630-285-0071
Fax: 630-285-0075

Dallas

Addison, TX

Tel: 972-818-7423
Fax: 972-818-2924

Detroit

Farmington Hills, Ml
Tel: 248-538-2250
Fax: 248-538-2260

Kokomo

Kokomo, IN

Tel: 765-864-8360
Fax: 765-864-8387

Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608

Santa Clara

Santa Clara, CA
Tel: 408-961-6444
Fax: 408-961-6445

Toronto
Mississauga, Ontario,
Canada

Tel: 905-673-0699
Fax: 905-673-6509

ASIA/PACIFIC

Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon
Hong Kong

Tel: 852-2401-1200
Fax: 852-2401-3431
Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755
China - Beijing

Tel: 86-10-8528-2100
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Hong Kong SAR
Tel: 852-2401-1200

Fax: 852-2401-3431
China - Nanjing

Tel: 86-25-8473-2460
Fax: 86-25-8473-2470
China - Qingdao

Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8203-2660
Fax: 86-755-8203-1760

China - Wuhan
Tel: 86-27-5980-5300
Fax: 86-27-5980-5118

China - Xiamen

Tel: 86-592-2388138
Fax: 86-592-2388130
China - Xian

Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

China - Zhuhai
Tel: 86-756-3210040
Fax: 86-756-3210049

ASIA/PACIFIC

India - Bangalore
Tel: 91-80-4182-8400
Fax: 91-80-4182-8422

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-2566-1512
Fax: 91-20-2566-1513

Japan - Yokohama
Tel: 81-45-471- 6166
Fax: 81-45-471-6122

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul

Tel: 82-2-554-7200
Fax: 82-2-558-5932 or
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068
Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069
Singapore

Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-572-9526
Fax: 886-3-572-6459
Taiwan - Kaohsiung
Tel: 886-7-536-4818
Fax: 886-7-536-4803
Taiwan - Taipei

Tel: 886-2-2500-6610
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE

Austria - Wels

Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828

Fax: 45-4485-2829

France - Paris

Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Italy - Milan

Tel: 39-0331-742611
Fax: 39-0331-466781

Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Spain - Madrid

Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
UK - Wokingham

Tel: 44-118-921-5869
Fax: 44-118-921-5820
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